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Typing practice 1
1. Type the following text
REDECORATING A HOUSE.
Home decoration opens up great possibilities for the practical, for not only is the work easy, but
there is something concrete to show for the labour.
If the worker is a novice he should start work on a relatively unimportant room to gain experience
before venturing on any of the main rooms in the house.
The importance of obtaining the very best materials cannot be over- emphasised, as good work
cannot be expected from cheap and usually inferior materials, be they paint, wallpaper or anything
else.
2. In the first paragraph.
• Type in the word person after the word practical and before the comma.
• Type the words profitable and interesting , following the word easy,
3. Delete the paragraph which begins......... If the worker......
4. Type in the following paragraph after the first paragraph.
Today there are many books and leaflets which will be useful if you have never attempted
this type of work before. However, it is a good idea to refresh your memory by browsing
through such guidance, even if you have carried out such work previously.
5. In the paragraph which starts......... The importance of...........
• Type the words and lasting following the word good.
• Delete cheap and usually following the words expected from
• Delete from be they paint to the paragraph end.
• Replace the comma ( , ) following the word materials with a full stop (• )
6. Save your file and print a copy.
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Typing practice 2

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Type the following text into a word document
Select the title: change to font size to 26pt and align centre
Select paragraph 1: change to font to Comic Sans, font size 18pt, and align justified
Find the word “tenacity”, replace with the word “determination”
Select paragraph 2: change to capitals
Select paragraph 3: change to italics and bold
Select paragraphs 4 & 5: Insert Bullet Points
Select all the text: change the font colour to green
Insert your name & date as a Header
Insert the page number as a Footer
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Save your document as Airedale Exercise

11.

Practice 3

1.
2.
3.
4.
5.
6.
7.
8.

Type the following text into a new word document
Select all text: change to Tempus Sans 12pt, green
Select the main heading: change to Broadway 24pt, red, underlined
Select the 3 sub headings: change to Eras Demi 20pt, blue, underlined.
Select the first paragraph: put a box round all the text
Select the third paragraph: change to italics
Go to search and replace: change“&” with “and”
Click above the heading The Statue of Liberty: insert a suitable ClipArt image &
resize
9. Click above the heading Ellis Island: insert a suitable ClipArt image & resize
10. Click above the heading Brooklyn Bridge: insert a suitable ClipArt image & resize
Save the document as NEW YORK ATTRACTIONS
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Name

Surname

Amanda

Buroess

John

Burton

Janet

Dyer

Jane

Evans .,

Sallv

Jones

Jill

Pennv

June

Perkins

Alan

Smith

Sandy

Steventon

Beginners
Exercises

Computer Art Signs

DTP

Handout
Exercises

Practice 4
1. Insert a table 10 rows with 8 columns
2. Type the following details

Fill in the following details using a piece of clip art in each cell.

Amanda; Beginners Exercises, signs John; Computer Art, DTP
Janet; Signs, DTP, Handout
Jane; Beginners Exercises, DTP, Handout Sally; Computer Art
Jill; Computer Art, Signs
June; Computer Art, DTP, Handout Alan; All areas
Sandy; Signs

Save and print a copy.
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Practice 5
Type the following passage:

2012 Stadium

London 2012 officials have revealed the design for the new £496m Olympic Stadium to be built in
Stratford, East London. It was initially expected to cost £280m but costs have been revised. Work on
the 80,000 seater stadium will begin three months ahead of schedule in April 2008. It will have to be
finished at least six months ahead of the opening ceremony in July 2012 to allow for test events to
take place. Lord Coe, chairman of the London Organising Committee, said it would be a 'stadium for
a new era'.
After the Olympic and the Paralympic games, the temporary seating will be removed to leave seating
for 25,000 and a permanent athletics track. It will have fabric wrapped around the walls on which
images can be projected. Organisers hope it will remain in use for many years to come and believe it
is a forward looking design.
Diagram of how the stadium will be pieced together

1. Check any mistakes which are highlighted by red or green underlining, or put the cursor to
the beginning of the passage and run the Spellcheck.
2. Save as ab Stadium, where ab are your initials.
3. Select the heading, centre it and make it size 16 and bold.
4. Select the main text and make it size 14.
5. Click in front of 'Work on the 80,000...' and press Enter twice to make a new paragraph.
6. Delete the figures 80,000 and 25,000 and replace them with equivalent words.
7. Select the following words and put them in italics: Stratford East London, Lord Coe
8. At the end of the document find an appropriate image
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Images
1. Open a new document.
2. With your cursor in the blank line, click on the Insert tab, and in the Illustrations group, select
Pictures.
3. Insert a picture of a computer
4. Move your cursor to the handle at the bottom right corner of the image, and when it becomes a
diagonal double-headed arrow , hold down the mouse button and drag the image to make it smaller.
(In the Size group, the Shape Height should be around 3.5 cm.)
5. With the image selected. click on the Layout Options button and note that In Line with Text is
selected.
6. Select Square from the With Text Wrapping options.
The image is now ‘floating’ and you should see the anchor icon .
7. Close the Layout Options callout.
8. Drag the image and watch the anchor icon.
The text will wrap, and the anchor icon will move as the image moves. The image ‘anchors’ itself to
the nearest paragraph.
9. Click on the Layout Options button and choose In Line with Text.
The image should return to its original position and is again inline.
10. Close the Layout Options call-out window.
11. Click on the Home tab, and in the Paragraph group, click on Centre.
Because the image is part of the paragraph, you can use the paragraph settings to position it.
12. Click on Align Left in the Paragraph group move the image back to the margin again.
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Spreadsheets – Exercise 1

1. Create the following table in a new spreadsheet.

Travel and Expenses Budget
Categories

Mon

Tue

Wed

Thurs Fri

Airfare
Car Rental
Hotel
Breakfast
Lunch
Evening Meal
Miscellaneous

218
49
68
5
6
18
6

0
49
68
5
10
22
8

0
49
68
4
14
19
4

245
49
68
5
9
24
9

0
49
68
6
7
30
4

1. Put borders around the whole of the table and between each cell.

2. Change the font of the heading “Travel and Expenses Budget” to Arial size 18.

3. Embolden the heading.

4. Embolden all column titles for the days of the week, the categories heading and all
subsequent categories.
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Spreadsheets – Exercise 2
1. Create the following table in a new spreadsheet.

House of Wearing
Summary of Departmental Income
Department

Budget

Income

Bedding
Kitchen
Materials
Gents Clothing
Ladies Clothing
Children’s Wear
Stationary
Music Store
Hi-fi and TV

1026
3834
766
2069
3925
3070
542
1685
1067

1137.64
4025.38
1055.66
2256.25
4038.50
4068.05
1060.34
1976.45
5271.68

1. Put borders around the whole of the table and between each cell.

2. Change the font of the heading “House of Wearing” to Arial size 18.

3. Change the font of the sub-heading “Summary of Departmental Income” to Arial size 16.

4. Embolden the heading and sub-heading.
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Exercise – PowerPoint
Activity: adding and editing slides
In this activity you will create a new presentation and practice adding slides and entering
different types of information.
1. Open PowerPoint. A new blank presentation will be created automatically, which should
look like figure 1. At first the presentation will only contain one slide (shown in the window on
the left) with the title slide layout.

Figure 1

2. Click in the box that says Click to add title and type ‘Common weeds’ add your name to
the subtitle box.
3. Open the Home menu and click New Slide
4. Now select Layout form the home menu and choose Content with Caption from the
drop-down menu that appears.
5. On your slide, add the following information about chickweed provided in the table below,
and find a suitable picture.
Title box
Second text box
Graphic box on righthand side
Chickweed
One of the common
Add graphic
weeds, with fragilelooking green stems and
leaves and tiny white
flowers. This is an annual
weed, so easily dealt with
– you can feed it to your
pet rabbit.
Convolvulus or Great
A notorious perennial
Add graphic
Bindweed
weed, it is almost
impossible to get rid of. It
forms strings of heartshaped leaved on twining
stems, which can work
their way up into trees or
over hedges. Large, white
trumpet-shaped flowers in
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summer. Any tiny bit left
in the soil will grow into a
new plant in no time
Groundsel

Dandelion

An annual, related to
Ragwort, without and
‘petals’, usually borne in
small clusters. Rubberylooking, small serratededge leaves. Anything
from an inch to a foot
high. It has fluffy seed
heads that will spread the
seeds all over your
garden.
Dandelions are easily
identified by their bright
yellow flowers and deep
taproots. They are
perennial plants and very
difficult to get rid of.

Add graphic

Add graphic

6. Insert three more slides and add the information about one of the weeds to each slide.
7. Create another slide, using the Title with Content layout. Add some text explaining how
to get rid of weeds. The information below is given as a short paragraph – pick out the key
points and then present the information as a bulleted list. Click in the Click to add text box
and enter your points one at a time.
Getting rid of weeds
It is important in most cases to uproot all of a weed otherwise it will re-grow. Use a hand fork
to loosen the roots of larger garden weeds.
For perennial garden weeds, a systemic weed killer such as glyphosate should be used. Use a fork
when digging weeds, as it will tease the roots loose; a spade will chop them up, multiplying the
problem. Garden weeds invading from adjoining ground can be deterred with a barrier of thick
plastic buried in the ground.

8. Add a border to your text

Exercise – Poster making (Publisher/Word)
Activity No. 1
1. Open a publication.
2. Insert a shape, then, rotate

ICT- Desktop Publishing Page 49
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3. Insert another shape, then change the fill and outline colour of the shape
4. Change the order of the two shapes you inserted.
5. Align two shapes.
6. Group the shapes you just aligned, then, align the group to the centre of the page.

Activity No. 2
1. Create or open a publication.
2. Insert a Clip Art picture. Use the search tools in the Clip Art pane to find a photograph of a family.
3. Crop the picture, then, resize it so that it fits well on the page.
4. Align the picture to the centre of the page.
5. Recolour the picture.
6. Apply a picture style.
7. Add a caption.
8. Compress the picture, then, close the publication and save.

Activity No. 3

1. Open a publication.
2. Create a table with two columns and eight rows.
3.Add text to the table. If you're using the example, you can simply copy and paste some of the text
from the existing table.
4. Insert an additional column to the left of the first column.
5. Merge two cells, then, split them again.
6. Align the text in the far-right column to the bottom left.
7. Apply a table style.
8. Select a row of cells and apply a border and fill colour.
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Outlook -Email
Write two e-mails, on separate sheets of paper, using the situation you created in 1. The maximum
length for each e-mail is 100 words.
•

e-mail 1: Write to the person you are going to meet. What do you need to tell them?
Perhaps you need to let them know what you want to discuss. Do you want them to arrange
anything for you?

•

e-mail 2: Write an e-mail to all your colleagues. Tell them about your plans and ask them if
they want you to take / do / find out / bring back anything.

Image creation
https://www.howtogeek.com/school/microsoft-word-document-formatting-essentials/lesson4/

Picture Tools
As always, when you want to edit a picture or any element place in a Word document,
you can click on it and the appropriate tab will appear on the Ribbon.
With pictures, that tab is “Picture Tools.” Here we see you can make all kinds of
corrections to the picture on-the-fly. For example, you can correct brightness and
contrast, the colour, add a border.
MS Word

Google Docs
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Image task 1
Create the following image using your word-processor

Image task 2
Create an image using shapes for the How-To Geek School
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